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ABOUT THIS GUIDE 

The instructions and descriptions contained in this document were accurate at the time of publishing; 
however, succeeding products and documents are subject to change without notice.  Therefore, 
Window Book, Inc. assumes no liability for damages incurred directly or indirectly from errors, 
omissions, or discrepancies between the product and this document.   
 
Go to www.windowbook.com to download the most current version of this document.   
 
This document is formatted for 2-sided printing. 
 
DAT-MAIL™ is a trademark of Window Book, Inc. 
The following are trademarks (indicated by ™) or registered trademarks (indicated by ®) are owned by 
the United States Postal Service:  USPS® and PostalOne!®. 
Mail.dat® is a registered trademark of the International Digital Enterprise Alliance, Inc. (IDEAlliance). 
Windows® is a registered trademark of Microsoft Corporation in the United States and/or other 
countries. 
All other product names are trademarks, registered trademarks, or service marks of their respective 
owners. 
 
Copyright © 2017 Window Book, Inc.  All rights reserved.  All intellectual property rights remain the 
property of Window Book, Inc.  No part of this publication may be reproduced, distributed, modified, 
displayed, transmitted, stored in a retrieval system, or translated into any human or computer language, 
in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, 
without the prior written permission of the copyright owner, Window Book, Inc., 300 Franklin Street, 
Cambridge, MA 02139. 

CONTACT INFORMATION 

  WINDOW BOOK, INC. 
 300 Franklin Street 
 Cambridge, MA  02139 
 
  Corporate: 617-395-4500 
 Client Services: 800-524-0380 
  postalspecialist@windowbook.com 
 Support: 800-477-3602 
  techsupport@windowbook.com 
 Fax: 617-395-5900 
 On the Web: www.windowbook.com 

http://www.windowbook.com/
mailto:postalspecialist@windowbook.com
mailto:techsupport@windowbook.com
http://www.windowbook.com/
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REVISION HISTORY 

This section contains a list of any significant changes that were made from the previously published 
version of this Guide, including a brief description of the change, the type of change made (i.e. Revision, 
New, or Deletion), a link to the location in the Guide where the change occurred, and any pertinent 
details relating to the change. 
 

CHANGE TYPE LOCATION IN GUIDE DETAIL 

Replaced logo Revision Document cover page 
Replaced existing logo with new 
Window Book company logo 
(February 2017). 

Updated section Revision 
ABOUT THIS GUIDE and 
page footers throughout 

Updated copyright information for 
2017. 
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GETTING STARTED 

SYMBOLS YOU SHOULD KNOW 

The following symbols appear throughout this document: 
 

 Where displayed, this Information icon denotes important information regarding the subject 
matter at hand.  The information is intended to provide helpful hints, references to other 
locations in the document to help further understanding about the current subject-matter, 
and/or include special requirements pertaining to specific subject-matter.  It is important that 
the information provided be read and thoroughly understood before proceeding. 

 

 Where displayed, this Attention icon is intended to make the reader take special notice as the 
information provided is critical in nature to the subject matter at hand.  It is not intended to 
lessen the importance of the information provided with the Information icon noted above; but 
to bring additional attention in situations of extreme necessity. 

 

 Where displayed, this Troubleshooting icon denotes helpful hints and tips for the subject matter 
at hand.  The information in the troubleshooting tip is intended to provide helpful hints and 
resolutions for some of the more common issues that can occur during operation. 

INTRODUCTION 

From the FAST web site: “FAST is a Postal Service™ initiative that improves the drop shipment and Origin 
Entry appointment scheduling processes through allocating appointment availability and decreasing 
dock wait times.  FAST is designed to interface with other postal applications and systems to enable 
ongoing transformation to an environment where the USPS® and customers have end-to-end visibility of 
the mail product from entry to delivery.” 
 
Window Book’ DAT-MAIL software provides an interface to FAST so that users can take advantage of the 
services FAST provides without ever having to leave their DAT-MAIL software. 
 

 The information and screen images provided in this document are based on DAT-MAIL version 
20.15.08.05. 
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REQUIREMENTS 

The requirements to be able to use FAST as documented in this Guide are as follows: 

 DAT-MAIL™ software version 20.15.08.05 (or newer) must be installed; 

 Clients must be registered to use FAST (https://gateway.usps.com/eAdmin/view/signin); 

 Clients must have the following information to be able to use FAST in DAT-MAIL: 

 Corporation ID (received from the USPS during FAST registration process); 

 Schedule ID (received from the USPS during FAST registration process); 

 Company Name (the Client’s company name); 

 User ID (the Client’s BCG login name); and 

 Password (the password associated with the Client’s BCG login name). 

 
 
 
 
 
 
 
 
 
 
 
 

https://gateway.usps.com/eAdmin/view/signin
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REGISTERING/ACTIVATING FAST 

To be able to use FAST, mailers must first register for FAST with the USPS® and then update their DAT-
MAIL registration key with Window Book to include the FAST option.  

USPS REGISTRATION 

Registering for the FAST service is performed from the USPS Business Customer Gateway (BCG) web site.  
Click this link to access the BCG login page:  https://gateway.usps.com/eAdmin/view/signin.   
 
Enter valid BCG login credentials and click the Sign in button. 
 

 
 
 
 
 
 
 
 
 
 
 
 

https://gateway.usps.com/eAdmin/view/signin
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The BCG Welcome page will display.  Select (click) the ‘Mailing Services’ menu option. 
 

 
 
The Mailing Services page will display.  Locate the “Schedule a Mailing Appointment (FAST)” service in 
the list and click the corresponding GET ACCESS button. 
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The service’s status will update to display “Pending BSA”. 
 

 

DAT-MAIL ACTIVATION 

After Window Book Clients have successfully registered to use FAST through the USPS, they must update 
their current DAT-MAIL registration key to include the FAST option.  To do this, Clients should contact 
Window Book Client Services.  Contact Information can be found at the front of this Guide. 
 
Once a new DAT-MAIL registration key containing the FAST option is received from Window Book, 
Clients need to update their existing DAT-MAIL software with the new key.  To do this, perform the 
following: 
 

1. Launch DAT-MAIL.  From DAT-MAIL’s main menu, select (click) the ‘Help’ menu option, then 
‘Registration’, and finally ‘New Registration’; 
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2. A Registration Wizard screen will display.  Click the Next button to continue; 

 
 

3. The next screen will display the existing registration key and will also contain two options for 
entering a new key.  Select the ‘Registration Key obtained.  Enter it’ option.  Click the Next 
button to continue; 

 
 
 
 
 
 
 
 
 
 
 
 
 



Fast Interface 
User Guide  Registering/Activating FAST 

©2017 Window Book, Inc.  All Rights Reserved.  Page 13 of 36 

4. Enter the new registration key received from Window Book into the field provided.  When 
the key is entered, the Next button will become active (enabled).  Click the Next button to 
continue; 

 
 

5. Click the Save Registration Key button.  Click the Next button to continue; 

 
 

 If an error occurs after the SAVE REGISTRATION KEY button is clicked, make sure the information 
recorded in the Customer Information screen in DAT-MAIL matches what was used when 
obtaining the new registration key from Window Book.  The customer data or information 
recorded for each must match for the new registration key to work. 
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6. Click the Finish button; 

 
 

7. A confirmation dialog will display.  Click the OK button to close the dialog and to complete 
the registration process.  The DAT-MAIL software will also close; 

 
 

8. Re-launch DAT-MAIL to begin using the software with the Fast module enabled. 
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CONFIGURATION & ACCESS 

The FAST interface must be configured in DAT-MAIL before it can be used.  Once the configuration is 
completed, the FAST interface can be accessed at any time from within an individual job or from the 
statement side.  

CONFIGURING FAST 

To configure FAST in DAT-MAIL, perform the following: 

 Launch DAT-MAIL.  From DAT-MAIL’s main screen, click the ‘3602’ icon; 

 
 

 The Statements for DAT-MAIL screen will display.  Select (click) the ‘File’ menu option and then 
select (click) the ‘Program Setup’ option; 
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 The System Setup screen will display.  In the list provided, select (click) the ‘FAST’ option.  The 
Client is required to enter the following fields: 

 Corporation ID (received from the USPS during FAST registration process); 

 Schedule ID (received from the USPS during FAST registration process); 

 Company Name (client’s company name); 

 User ID (the Client’s BCG login name); and 

 Password (the password associated with the Client’s BCG login name). 

 
In addition, the Client has the option of working in the PostalOne!® TEM environment if they 
wish versus the production or PROD environment.  To work in the TEM environment, select 
(check) the ‘Communicate to USPS TEM Site’ option. 

 

 Not all entry points and appointment scenarios are available for testing in the FAST environment. 

Click the OK button when finished.  The configuration is complete! 
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ACCESSING FAST 

FAST is accessed two ways:  from within individual jobs; and from the Statement side. 
 

 The information and screen images provided in this document are based on DAT-MAIL version 
20.15.08.05. 

 Statements must be generated for a job or Mail.dat file prior to attempting to use FAST. 

Accessing FAST From Within Jobs 

To access FAST from within an individual job, perform the following: 
 

1. To access FAST, display the jobs list in DAT-MAIL.  Highlight (select) a job from the list and 
click the Select button to open the job. 

 
 
 

2. The Advanced Navigator (default) screen will display. 

 If the Client has DAT-MAIL set to use the Navigator screen, it will display in lieu of the Advanced 
Navigator when the job is selected/opened. 
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From the available tabs located at the bottom of the screen, select (click) the ‘Other Views’ tab.  A 
selection of options will display just above the ‘Other Views’ tab.  Select (click) the ‘Mail Schedule 
View’.   

 

 
 

 The ‘Mail Schedule View’ can also be displayed by selecting it from within the ‘View’ menu 
located at the top of the Advanced Navigator and Navigator screens. 
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3. The Mail Schedule View screen for the selected job will display.  Each ‘Entry Facility’ (i.e. 
entry point) contained within the job will be listed.  In addition, accessibility to the FAST 
interface will be present.  Select (highlight) an Entry Facility from the list and click the FAST 
link (in the example here, the “SCF South Jersey, NJ” Entry Facility is selected); 

 
 

4. The FAST Appointment – TEM screen will display for the selected Entry Facility.  The TEM 
interface displays because the option to use TEM was selected or enabled in the FAST 
configuration screen in DAT-MAIL (refer to CONFIGURING FAST for more information).   

In both the TEM and production environments, the Job ID associated with the selected Entry 
Facility displays in the screen’s title bar, for easy reference.  This occurs when accessing 
FAST from within an individual job. 
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If the Client was using FAST in the production environment, the main or production 
interface screen would display (i.e. the “TEM” label would not display in the screen’s title 
bar).   

 

 
 

In addition, whether or not the Mail.dat file has been exported to PostalOne! (P1) is 
signified.  If this text (i.e. “Mail.dat file uploaded to PostalOne!”) is grayed out and the 
corresponding box is not checked, this means that a release of the Mail.dat file to P1 has not 
occurred (see image below) and P1 is not yet aware that a Mail.dat file is coming.   

 

 
 

This screen or interface will be used to set up the order entry appointment for the selected 
Entry Facility found within a specific job or Mail.dat file.   
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Accessing FAST From The Statement Side 

 The information and screen images provided in this document are based on DAT-MAIL version 
20.15.08.05. 

 Statements must be generated for a job or Mail.dat file prior to attempting to use FAST. 

To access FAST from the statement side in DAT-MAIL, perform the following: 
 

1. Access DAT-MAIL’s statements module by clicking the 3602 icon; 

 
 

2. The Statements for DAT-MAIL screen will display.  Select (click) the ‘Reports’ menu and 
select ‘Drop Ship Clearance 8125’; 
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3. The 8125 Statement Listing window will display.  Statements, along with their entry points, 
can be viewed by Control Number or Date/Permit number.  Select (highlight) an entry point 
from the list of available statements and click the Change button; 
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4. The Changing 8125 / 8017 Statement# window will display for the selected statement/entry 
point.  With this window open, click the FAST button located in the main Statements for 
DAT-MAIL screen; 

 
 

5. The FAST Appointment – TEM Test Environment Connection screen will display for the 
selected Entry Facility.  The TEM interface displays because the option to use TEM was 
selected or enabled in the FAST configuration screen in DAT-MAIL (refer to CONFIGURING 
FAST for more information).   

 
 
If the Client was using FAST in the production environment and accessing it from the 
Statement side, the main or production interface screen would display (i.e. the “TEM” label 
would not display in the screen’s title bar).   
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In addition, the screen will display the ‘PVDS Statement’ number, which correlates with the 
statement’s ‘Control #’ (refer to the image displayed in Step 3 above), along with the entry 
point associated with that statement.   

 

 
 

This screen or interface will be used to set up the order entry appointment for the selected 
statement/entry point. 
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COMPONENT DESCRIPTION & USE 

The FAST appointment screen or interface is split into two sections:  The control panel located on the 
left; and a larger display area located on the right.  What is visible in the display area is dependent on 
what is selected in the control area. 
 

 
 

The Control Panel contains an overview of the details pertaining to the 
selected Entry Facility an appointment is to be scheduled for.  This overview 
consists of the name of the Entry Facility selected; the Class of Mail for the 
job, the Proc Cat (i.e. Processing Category); the mailing date displayed in the 
Mail Schedule View; the registration/configuration details entered in DAT-
MAIL Statements (refer to CONFIGURING FAST for more information); a 
Request ID that is automatically generated by the system; and finally, DAT-
MAIL fills in the Facility Locale Key that pertains to the selected destination. 

 
The next section of the screen, the “Appointment Method” section, is used to 
schedule an actual ‘Appointment with Contents’; set up a ‘Shell Appointment’; 
update a Shell Appointment (i.e. ‘Contents Only for Shell Appt’).  When the 
option ‘None Selected’ is selected, the Display Area of the FAST Appointment 
screen remains blank. 
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APPOINTMENT WITH CONTENTS 

The ‘Appointment with Contents’ option refers to making an appointment for an Entry Facility when the 
Client already knows what the contents of the shipment is going to be (e.g. pallets, trays, or sacks).  
Clicking the Appointment with Contents button displays an appointment screen. 
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 Image Reference :  This section of the screen automatically displays the Scheduler Content ID 
as entered for the FAST settings in DAT-MAIL Statements (refer to CONFIGURING FAST for more 
information).  In addition, system-generated IDs are populated in their corresponding fields 
when an appointment is set and/or cancelled; 

 Image Reference :  The main details of the appointment itself are set here.  Specific settings 
may or may not display depending on the various options that are, or are not, enabled: 

 Appointment Type:  Using the drop down provided, 
select what the shipment is going to contain.  The 
options are:  Pallet; DropAndPick; Speedline; and 
Bedload.  Based on the entry point selected and the 
information contained in the Mail.dat file, DAT-MAIL’s FAST interface automatically 
selects an option for the user; however, the user can change this setting if need be; 

 Appointment Date:  Click the calendar icon and select a date for the appointment; 
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 Appointment Time:  Type in a requested 
appointment time following the format 
displayed (i.e. HH:00 24hr), or leave this field 
blank and FAST will return a list of available 
times for you to choose from when the 
Request Available Appointments button is 
clicked.  If left blank and once FAST returns 
the requested time information (e.g. “There 
are 10 time slots available”), click the down arrow and select a time from the now 
available list; 

 Pickup/Del:  Select whether the shipment is to be a ‘Pickup’ or 
‘Delivery’ using the drop down provided; 

 Sched In-Home Date / Sched In-Home End:  Click the 
corresponding calendar icon to specify a date range for in-home delivery if the content 
being mailed is time-sensitive.  If these dates are populated in the Mail.dat file, these 
same values will auto-populate in these fields.  The user can delete them out prior to 
scheduling the appointment, if they wish. 
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 Image Reference :  Use the ‘Appointment Type’ section of the screen to enable a ‘Multi-Stop’ 
Appointment, and/or a ‘Recurring Appointment’: 

 Multi-Stop Appointment:  Select (check) this box to set up a 
multi-stop appointment.  When this box is checked, the 
Select Existing Multi-Stop button is enabled, allowing the 
user to select/use a multi-stop appointment that was 
previously created from a list provided.   

If the correct multi-stop scenario does not exist, one will be created when this option is 
selected (checked) and an appointment is set.  The system will auto-generate a ‘Stop 
Number’ and display it in the corresponding field on the screen (see image below); and 
 

 
 

 Recurring Appointment:  Select (check) this box to create a 
recurring appointment.  When this box is checked, the Select 
Recurring Appointment button is enabled, allowing the user 
to select and use an already created recurring appointment.   

 
If the user wishes to create a recurring appointment, additional information will be 
required.  An Effective Start and End Date will have to be entered, and a Day Frequency, 
and a Week Frequency will need to be selected. 
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 Image Reference :  This portion of the appointment screen provides 
ease-of-use functionality for each appointment: 

 
 
 
 

 eVS File Used:  This option, when selected (checked), allows the user to enter/apply the 
eVS File number that is being used.  Once enabled, the screen will update and a field 
where the eVS File Number must be entered displays (see below); 
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 View Containers Button:  Clicking this button updates the display area of the FAST 
Appointment screen, showing the list of containers associated with the selected Entry 
Facility. 

 When the VIEW CONTAINERS button is clicked, the label on the button 
changes to read “View Appointment”.  Clicking the VIEW 
APPOINTMENT button will navigate the user back to the Appointment 

screen called out in Image Reference  above. 

 

 
 

Container information can be edited by selecting the container and clicking the Edit 
Selected Container button.  An Edit Container Information screen will display.  Changes 
can be made to the container within this screen.  When the OK button is clicked, the 
changes will be written back to the original Mail.dat file. 
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 Partners/CSA Button:  Clicking this button updates the display 
area of the FAST Appointment screen, showing the Submitting 
Party Information as taken from the Mail.dat file.  In addition, 
CSA and Partners information can also be viewed and queried 
from P1; 

 
 

 View Event Log:  All communication between DAT-MAIL and FAST occurs using XML 
messaging.  Clicking the View Event Log button displays a FAST Event Log screen in 
which the XML communication string, both what was sent to P1 and what was returned 
by P1 can be viewed; and 
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Each XML log can also be saved to a folder on the computer by clicking the Save XML 
button.  An XML Write Information… screen will display providing a default folder where 
the XML log will be saved to (can be changed), along with a default file name that will be 
used. 
 

 
 

 Close FAST Button:  Clicking this button closes the FAST interface. 
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 Image Reference :  This section of the appointment screen contains function buttons 
pertaining to requesting, checking availability of, making, updating, and canceling appointments.  
Whether or not some buttons display is dependent on some of the available options being 
selected (e.g. Recurring Appointment).  And whether or not a button is active or enabled is 
dependent upon where the user is in the appointment creation process. 

In addition, the lower part of the screen is a window that displays communication results 
between the FAST DAT-MAIL interface and P1, which can include available time slots, 
confirmation of appointment time/date, communication errors, entry facility issues, etc. 
 

 
   
 
 
 
 
 



Fast Interface 
User Guide  Component Description & Use 

©2017 Window Book, Inc.  All Rights Reserved.  Page 35 of 36 

SHELL APPOINTMENT 

The ‘Shell Appointment’ option refers to making an appointment for a shipment that is to occur; 
however, the contents of that shipment are not yet known.  The user can make the appointment and 
hold the appointment time.  Once the actual contents of the shipment are known, they can then go back 
into FAST and update the appointment with the details of the contents – refer to Contents Only For Shell 
Appointment below. 
 
The functions and settings used for creating a Shell Appointment are very similar as those used for 
creating an ‘Appointment with Contents’ (refer to Appointment With Contents above for more 
information). 
 
When a Shell Appointment is created, a ‘Consignee Appointment ID’ and a ‘Consignee Content ID’ is 
generated by the system.  These are the IDs that should be used to identify the Shell Appointment so as 
to update it with the contents of the shipment once they are known (refer to Contents Only For Shell 
Appointment). 
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CONTENTS ONLY FOR SHELL APPOINTMENT 

The ‘Contents Only for Shell Appt’ is used after a Shell Appointment has been made and once the 
contents of the corresponding shipment for that appointment are finally known.   
 
The user would access the Shell Appointment created for the selected Entry Facility using the system-
generated Consignee Appt and Content IDs, update the details with the correct Contents, click the 
Select Carrier button and select a carrier from the list provided, and click the Add Content to 
Appointment Shell button.   
 
 
 
 
 


